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CYPE Architecture is a free architectural BIM-3D modelling tool designed 

specifically for multidisciplinary collaboration via its integration in the Open BIM 

workflow, facilitating the design and modelling of buildings using a 3D work 

environment. The application allows exports to the standard IFC file format. 

1 Main functions of the programme 

 

The application’s tools are divided into three main tabs or groups: Sketch, Architecture and 

Furniture. Although there are no limits for the direct and immediate use of the tools for 

creating construction elements, the application will propose a possible approach using the 

so-called "sketch" tools, i.e., lines, contours, plans, etc., in which the subsequent 

introduction of architectural elements and furniture can be based. Two possible options or 

strategies for developing a project are therefore proposed: direct 3D/BIM modelling and 

sequential modelling, preceded by a traditional geometric design process.  

On the one hand, the programme has been equipped with tools that come from traditional 

modelling (surfaces, edges, intersections, extrusions, curves, etc.) and, on the other, with 

tools that come from the BIM modelling environment (walls, floor slabs, roofs, columns, 

etc.); both combined, they allow users to switch from the conceptual to the architectural in 

a simple way.  

 

The Sketch tab includes creation and editing tools typically found in traditional design 

programmes such as straight lines, curves, polygons, extrusions, offsets, intersections, etc. 

These tools will allow flat or three-dimensional geometries to be created which can then be 

the base of the subsequent developments of floor plan layouts or three-dimensional 

envelopes, in this case, making use of the tools included in the Architecture tab.  
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The Architecture tab includes all the tools for entering and editing the elements that will 

make up our architectural BIM model. Among the tools for creating construction elements, 

we find drop-down menus for vertical elements (walls, curtain walls, lattices, columns, 

railings), horizontal elements (floor slabs, suspended ceilings, beams), roofs (tiles, slope 

formation), openings (windows, doors, skylights, etc.) or vertical connections (stairs, ramps, 

and lifts). The editing tools will include, on the one hand, traditional tools such as edit, 

move, copy, rotate, and, on the other hand, specific tools for geometry editing and 

intersection solutions. We also find other groups for creating spaces or creating and 

managing reference elements and organising the model (levels, types, or labels). 

 

Lastly, and second in importance, the Furniture tab includes the necessary tools to provide 

context to our model and assist when distributing and organising spaces and uses. The 

different groups will help enter and edit furniture elements, home appliances, sanitary 

appliances, and garden elements. 
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2 QuickStart 

2.1 Creating a new project and a new file in CYPE 

Architecture 

Project should not be confused with File. When using an application integrated in 

BIMserver.center, users will have the chance to create a new job (file) integrated in a 

BIMserver.center project.  

CYPE Architecture is no exception. When launching the application and clicking on New, 

you will be offered the possibility of creating a new project and then integrating it into an 

existing project in BIMserver.center. You will also have the option of creating a new project, 

in which case the project created will be visible from BIMserver.center from that moment 

onwards. 

If linked to an existing project, the programme will offer the possibility to include files that 

already exist in that project (models that will be visible and can be used as a reference in 

CYPE Architecture). 

In any case, once the work file has been created, the blank canvas can be accessed, 

allowing users to start entering information. 

 

2.2 Reference elements: grids, lines and arcs 

If the project being developed requires a certain structural order, we may want to create 

some reference elements; in CYPE Architecture, these reference elements are called Grids. 

During the design phase, these grids can be used to draw any construction or sketch 

elements. Flat or three-dimensional grids can be generated, this way, users can have a 

common reference in all levels of the project. As well as grids, the programme allows a 

freer introduction of reference lines and arcs. 

References are not model elements and will only support the 2D/3D drawing and creation 

of construction elements. All references (grids, lines or arcs), can be created in the 

Reference group in the Sketch tab.  
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2.3 Creating Levels and Types  

Levels can be introduced from the Architecture tab. Creating levels is fundamental for the 

correct use of the application, levels will allow work planes and work views and will usually 

correspond to the different architectural levels or floors of the buildings. For the correct 

management and export of the model, all the elements in the Architecture tab should be 

associated to a level. When a new level is created, the programme will offer the chance to 

create plan views associated with them. 

 

Also, if desired, the programme will allow templates from external files to be imported so 

they can be inserted in each of the previously created levels (both image and CAD files, 

with *.dxf, *.dwg or *.dwf formats). 

Once the levels have been created, Types should be created for defining common 

construction elements (typology of external walls, floor slabs, etc.). The definition of types 

will simplify the introduction of common use elements (which will adopt the type’s 

properties) and will facilitate later editing. 

 

 

2.4 Creating views and using the graphic window 

 

The CYPE Architecture graphical environment includes some side panels. One of them is 

the Views panel. From this panel, the work views for our project can be created and 

managed. We should recall that, in the previous section, the possibility of creating plan 
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views associated with the created levels was mentioned. The views created by this 

procedure will be visible in this panel.  

The panel has tools in its top bar. This bar contains the following tools, among others: 

 Create. With this tool, users can create views for floors, reflected ceilings, elevations, 

sections, generic (plane defined by three points) or 3D views 

 Edit. Allows the existing views to be edited (double clicking on the selected view will 

have the same effect). Editing allows the reference (name) or the planes that define the 

cutting height or visible ranges to be modified and also allows imported levels or files 

to be associated with them, when available. 

 Save the start scene. The views offered by CYPE Architecture are not static, meaning, 

the model can be orbited to facilitate its modification in any view; however, the views 

will have a reference or start scene (i.e., in the case of a floor view, this view will 

coincide with a plane perpendicular to the z-axis). This tool will allow that start scene to 

be defined. 

 Go to start scene. Allows the defined start scene to be recovered by using the 

aforementioned tool. 

2.5 Viewing control and selecting objects 

The CYPE Architecture graphic window will occupy most of our screen; in this window, the 

interaction with the model will take place and both Sketch and Architecture elements, will 

be introduced. 

Its use is intuitive and analogous to that of any other three-dimensional modelling or 

design programme. Using a three-button mouse with a scroll wheel eliminates the need to 

use specific tools; scrolling with the wheel allows users to zoom into the model, pressing 

the centre button and moving the mouse will allow the scene to be framed, lastly, the 

previous action along with simultaneously pressing the SHIFT key allows the scene to be 

rotated. 

Clicking the left mouse button allows users to select objects and clicking the right mouse 

button allows them to cancel selections or actions that are in progress. Their selection 

along with holding down the CTRL key allows multiple selections whilst holding down the 

CAPS LOCK button will allow previously selected elements to be deleted. Clicking the left 

mouse button will allow the crossing method to be used, depending on the direction in 

which the frame is created, it will be possible to select contained or intersected elements, 

the type of line shown by the frame itself will indicate whether we are in the first or second 

case.  
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It should be noted that the native file is protected at all times; this process does not share 

any native information, only a screenshot of the model in standard IFC format, which is 

enough for the development process to continue in other software applications. 

2.6 Creating and managing layers 

The different elements of the model, both those from the Sketch tab and those from the 

Architecture tab, can be classified via an editable layer system by the user. The aim is to 

allow a classification that facilitates the users’ 3D modelling of the building.  

The Layers panel, besides showing the list created, will allow the visibility, transparency or 

locking of each one to be activated. A top toolbar allows users to create, delete, sort the list, 

or assign the selected elements on the model to a previously defined layer. 

 

 

2.7 Connecting to BIMserver.center 

While it makes little sense to export to upload information once our CYPE Architecture 

model has been started (and linked to a BIMserver.center project) until we have made 

progress in its development, the Update button will allow us to know the status of the 

project and the different files linked to that project (dates, changes, source applications, 

etc.) at all times; in addition, and above all, it will allow us to import and/or update any of 

the files linked to that project. Having external reference files will allow a coordinated 

design to be carried out. These files can be used as a sort of "three-dimensional template" 

to facilitate coordination. In fact, by editing each of the existing views in the file, you can 

activate the visibility (opaque or transparent) of any of the imported models. 

With all the aforementioned points in mind, the modelling process can begin. Once the 

modelling has been totally or partially completed, the model can be shared and made 

available to all collaborators by simply clicking on the Share tool. Clicking on this button will 

trigger a series of operations transparent to the user (generating an IFC file and uploading 

this file and any associated files to BIMserver.center, thanks to the preinstalled 

BIMserver.center Sync application) that will simply add (or update) the IFC version of the 

model hosted in the cloud, i.e., on BIMserver.center.  
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The group of tools called BIMserver.center also contains a series of direct connections to 

other programmes; clicking on these buttons will not only launch the corresponding 

application but will also create a file linked to the project.  

At the end of the group the user is displayed; clicking on this symbol offers a direct link to 

the BIMserver.center cloud. 
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3 Step by step 

3.1 A walkthrough of the interface 

CYPE Architecture presents a simple and intuitive interface oriented towards creating a BIM 

model, which is naturally three-dimensional, consisting of correctly classified and 

parameterised elements. 

The graphical environment is divided into three main parts: the top toolbar, the side panels 

on the left and the graphical window occupying the largest area.  

 

 Toolbar. This bar contains all the creating and editing tools; it contains three tabs 

which in turn hold the tools for creating and editing Sketch, Architecture and Furniture 

elements. Activating each tab opens the groups of tools related to that type of object; it 

is important to note that the editing tools will be specific to that type of object (an 

architectural object cannot be edited with the sketch editing tool and vice versa). 

 Side panels (Views, Layers and View). It contains two main panels with two specific 

functions: creating and managing project views and the layers in which the model 

elements can be organised. There is also a third linear panel with display options; this 

panel allows individual objects or those belonging to specific categories (symbols, 

sketches, textures, or tiles) to be hidden.  
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 Graphic window. It will be the main window for designing and interacting with the 

model. In the top part there is a series of options and tools that allow the projection 

and type of projection to be defined, the model to be sectioned or the representation 

type to be chosen.  

 

 Other bars. There is a small bar at the top of the program and a dialogue line at the 

bottom; both bars are common to all CYPE programs and contain various functions, 

including the following: importing and activating CAD or image templates, activating 

the options for Object snap, Draw grid, (absolute, relative, and polar) Coordinate 

introduction, Orthogonality, etc. They are of significant help when entering data and 

allow the geometry introduction mode to be personalised. Lastly, a general 

Configuration option is included that allows users to configure project units or 

background colours, for example. 

 

3.2 Creating a new job and linking to a new 

project 

Project should not be confused with file. When starting the application and clicking on New, 

a new job will be created and then integrated into an existing project in BIMserver.center. 

Users will also have the option of creating a new project in BIMserver.center, in which case, 

the project created will be visible on the platform from that moment onwards. 

 

Steps to follow to create a new job:  

1. Click on the application icon and File > New. Complete the File name and 

Description information. If necessary, enter an alternative path to the one 

provided with the Examine button.  

2. Click on Create a new project to generate a new project in BIMserver.center 

(alternatively, an existing project may be selected, and the new CYPE 

Architecture model may be linked).  

3. Enter the requested information for defining the new Project. 

4. Once the data has been entered and the Accept button has been selected, 

users will access the graphical environment with a blank graphic window, 

showing the existing level with elevation 0.00. 
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3.3 Levels 

The Levels tool will allow planes and work views that would normally correspond to the 

floor plans of the building to be created (although users can create as many as they desire). 

While creating them, the programme will offer the chance to create associated plan views.  

 

In order to link to a project with BIMserver.center you will need to have an account. 

Registration can be done quickly and free of charge at https://bimserver.center/en. 
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The tool is available in the Architecture tab in the BIM model group. The menu will allow 

the associated levels and elevations to be created and managed.  

 

 

 

There is a powerful tool in the BIM model group of tools: Copy from another level. This 

tool, as its name suggests, will allow elements to be copied from one reference level to 

another. 

 

 

 

Once the objects belonging to a specific category have been copied, you will see that, 

despite maintaining their shared features, the new elements created will be assigned to 

the target level and will have adopted a new individual reference. 

Steps to follow for copying elements from one level to another:  

1. Click on the Copy from another level tool. 

2. In the dialogue box, select the levels to and from the one where you wish to 

copy the objects. 

3. Filter the categories of the objects to be copied and click Accept. 

 

 

If associated views have been created, they can be edited from the view panel; to do 

so, simply double-click on the name of the view. 

 

Steps to follow for creating new levels:  

1. Click on the Architecture button > Levels. 

2. Click on the + sign to add a new level; next, enter a reference, an associated 

elevation and activate the corresponding checkbox if you wish to Create (an 

associated) floor view (this action will add a new view to the Views side panel).  

3. Once it has been created, the view can be edited or repositioned with the tools 

available in the menu. 
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3.4 Grids and other references  

Grids facilitate structured geometric modelling. During the design phase, you can use these 

grids to draw any construction or sketch element.  

 

 

 

Steps to follow for creating grids:  

1. Click on the Sketch button > Grids. 

2. Click on the + sign to add a new grid, next, enter a reference. 

3. The grid can be freely positioned and aligned; to modify its origin and 

orientation, enter the relevant coordinate and rotation data in the Position 

and Orientation section. 

4. Aside from its position in the XY plane, the grid can be located at a specific 

elevation, adopt a specific colour and text height. All these options must be 

configured in the View options section. A checkbox can activate or deactivate 

the visibility of the new created grid (without affecting the visibility of the 

others). 

5. Add lines in the X direction. The + sign will allow new lines to be placed in a 

specific (absolute) coordinate to be entered freely. 

6. Add lines in the Y direction. 

7. Add lines in any direction. To do this, simply define the coordinates of the 

ends and the label. 

If several grids have been created, their visibility can be controlled individually by 

activating/deactivating the Visible checkbox in the View options section. 
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3.5 The Sketch tab 

The Sketch tab includes features and tools found in traditional modelling programmes. 

In addition to the aforementioned References group, there are two groups of drawing and 

editing tools; these editing tools are specifically for sketch elements (they cannot be used 

for editing architectural elements and vice versa). 

The Drawing group includes the following tools: Line, Arc (given centre, start and end and 

3-point), Quadrilateral, Circle, Ellipse, Polygon, and Inscribed polygon. 

 

Depending on the drawing tool activated, a series of options will appear to graphically 

define the element to be created; for a Line simply enter a start and end point (each new 

point will define a new segment from the end point of the previous section), right clicking 

the mouse will allow disconnected elements to be entered, right clicking again will 

deactivate the tool. Other elements will require supplementary data to be entered; the Arc 

will need to be defined by three points or by the centre, start and end; the Quadrilateral 

can be defined by three points, diagonally or by width and height parameters; the Circle 

requires a centre and a radius; the Ellipse requires a centre and two radii; the Polygon 

requires the continuous entry of the points defining the vertices (right clicking the mouse 

will close the polygon) and the Inscribed polygon requires a circle and number of sides to 

be defined.   

Once any of the aforementioned tools has been activated and during the introduction by 

points, the usual options will be displayed; on the one hand, there will be an Entry mode 

bar that will allow the 3D or 2D entry mode to be chosen, the latter based on a reference 

plane and a possible vertical displacement from the previous one. Choosing the 

appropriate entry mode is crucial for entering the points in the workspace correctly. On the 

other hand, a small floating toolbar allows users to Erase the last introduced point or 

simply Erase all introduced points. 

A defining feature of the procedures proposed by CYPE Architecture is the following: any 

closed outline will cause the automatic creation of a surface; this surface can be used for 

creating three-dimensional elements, both architectural (such as walls and floor slabs) and 

sketch (using the Extrude tool). Using surfaces opens a door to freedom in element design 

that will be discussed further on. In the same way that closing an outline creates a surface, 
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erasing one of the elements that defines that outline will result in the elimination of that 

surface; to recreate a surface, the outline must simply be closed again.  

Another peculiar feature is that any intersected line will produce two independent lines.  

Sketch elements created with the tools in the Sketch group can be edited with the tools 

included in the Edit group. This group includes the following tools: Edit, Delete, Copy, Move 

element group, Rotate, Rotate about an axis defined by two points, Symmetry (with and 

without copy), Intersect, Scale, Extrude, Invert, Offset. Given that these tools are the usual 

ones in any design programme, we will only comment on some interesting differences: 

 Intersect. When applied on two surfaces it will generate a new surface as a result of 

the intersection. 

 Extrude. Will allow volumes delimited by sketch surfaces to be obtained from the 

extrusion of surfaces. 

 Invert. Will modify the normal direction of a surface plane; this could modify the 

assigned colour and direction of growth (for example, when used as the generator or 

an architectural element). 

 Offset. When applied on a surface it will allow a new equidistant contour to be 

obtained, either interior or exterior. 

 

Lastly, as with architectural elements, sketch elements can be associated to a colour, a 

label, or they can be measured (linearly or superficially); the tools related to these 

functions complete the main toolbar. 
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Steps to follow for creating cylindrical walls using Sketch tools:  

1. Select an appropriate view and layer for working. 

2. Click on the Circle tool that can be found in the Sketch tab, in the Drawing 

group.  

3. Once the tool has been activated, a small floating menu will appear that 

allows the properties of the circle to be defined: 

 Number of sides. The circumference that borders the circle will be 

represented by a polygon; the value of this parameter will allow the 

precision of that polygon to be defined 

 Radius. If this parameter is activated, the radius of the element can be 

defined parametrically; otherwise, it can be defined graphically in the 

graphic window 

4. Once the geometry of the circle has been defined, it is time to place it in 

the graphic window. The centre and, if necessary, the window, can be 

defined by clicking on the graphic window. To do this, it is important to 

note the following: 

 3D/2D mode. A floating window will allow activating both the 2D mode 

and the reference to a work plane (if users are working on a view 

associated to a level, the choice of work plane will be determined by 

the view itself and the selector will remain inactive), and the 3D mode 

(in this case, the element can be freely located in space, in the 

dimension associated to the selected point). The 2D mode will also 

allow the entry of a vertical displacement, measured from the 

reference plane. 

 Once the circle has been created, as it is a closed outline, a surface 

delimited by the outer polygon will be created at the same time. 

5. Click on the Offset tool which can be found in the Sketch tab in the Edit 

group and click on the inner surface of the circle. 

6. Move to the inside or outside and see how the shape equidistant to the 

original has been updated; click on the desired point (if the Allows for 

dimensions to be defined when introducing each element option is 

activated, the offset can be entered numerically). 

7. Click on the Extrude tool, which can be found in the Sketch tab, Edit group, 

and click on the surface between the two polygons created. 

8. Move along the axis perpendicular to the surface to define the height of 

the extrusion and click on the desired point (if you have enabled the option 

Allow dimensioning when entering each element, you can enter the height 

numerically). 
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The extrusion will result in the creation of a set of surfaces that delimit the volume of the 

extrusion. Any of the resulting surfaces will serve as the generatrix of a possible 

architectural element, if necessary. 
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3.6 Creating architectural types 

Previously defining typologies will simplify entering elements later on. Moreover, in case of 

any later changes, assigning elements to a given type will allow the features associated with 

all elements belonging to that type to be changed simultaneously. 

 

 

Once some shared features per type have been defined, the creation of new elements will 

be much simpler. 

 

The extrusion will result in the creation of a set of surfaces that delimit the volume of the 

extrusion. Any of the resulting surfaces will serve as the generatrix of a possible 

architectural element, if necessary. 

Steps to follow for creating types:  

1. Click on the Architecture button > Typology of the architectural elements

. 

2. Click on the category to which you wish to assign new types (e.g., columns) 

3. Click on the + sign to add a new type. Depending on the category, a menu will 

appear with the options for defining elements belonging to that category. In 

any case, the Reference field must be filled in to identify the new type 

created. If desired, other identifying fields can be added, such as Description 

or Tags. For columns, other specific parameters must be defined: Category 

(Rectangular or Circular), Dimensions and Colour. 

4. Once the features of the newly created type have been defined, a new line 

will appear in the Typology of the architectural elements window. From this 

window, types can be edited, deleted, exported, or imported. 
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3.7 Vertical elements I: Columns  

Although entering columns can be done in a completely free and individual way, the prior 

definition of types will, as we have already seen, make it easier to create new elements.  

 

 

 

Steps to follow for creating columns :  

1. Select the appropriate view and activate, if necessary or 

convenient, the reference grid. 

2. Click on the Column tool which can be found under the Architecture tab in 

the Construction elements group in the Vertical elements drop-down 

menu. When clicking on Vertical elements, a small floating toolbar will 

appear that can be attached to one of the sides of the graphic window; the 

toolbar includes the Column tool along with others. 

3. Once the tool has been activated, a small floating menu will appear, 

allowing users the features of the new column being created to be defined, 

if a column type has been previously defined, these features can be loaded 

directly via the pencil: 

 Reference. The one proposed by the application can be modified. 

 Level. Reference level for the new element, important for filtering 

later on. 

 Height. 

 Type. If types have been previously defined, one of the existing ones 

can be selected from the folder icon; this will cause the defined 

parameters for the type to be filled in and linked to the features 

defined for it. 

 Category, Dimensions, Colour. These can be freely defined if the 

element is not associated with a predefined type. 

 Insertion point. Any of the references shown graphically may be defined. 
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4. Once the features of the column have been defined, it is time to place it in 

the graphic window. To do this, several issues must be considered: 

 3D/2D mode. A floating window will allow both the 2D Mode and the 

reference to a work plane to be activated (if we are working on a view 

associated to a level, the choice of work plane will be determined by 

the view itself and the selector will appear inactive), and the 3D Mode 

(in this case, the element can be freely located in the space, in the 

dimension associated to the selected point). The 2D Mode will allow 

the introduction of a vertical Offset, measured from the reference 

plane. 

 Orientation. A second floating window allows the orientation of the 

element to be defined; however, once placed, a magenta-coloured selector 

will allow the created element to be rotated. This procedure is common to 

other CYPE modelling tools. 

 References. If grids are displayed, both the lines and the intersections 

between them will be snapped for the exact location of the column. 

Additionally, if Object snap (Endpoint, Midpoint, Nearest, etc.) is 

activated, pre-existing elements in the scene will serve as a reference for 

entering new elements. 

5. Finally, left-clicking the graphic window will insert and create the new 

column. The tool will remain active so that new elements can be inserted 

sequentially. Right clicking the mouse will deactivate the tool. 
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3.8 Horizontal elements: Floor slabs 

The previous explanations, referring to both creating columns and the aforementioned 

considerations, can be completely extended to the creation of other construction elements. 

The Floor slabs tool includes some additional features that will be discussed below. 

 

All the construction elements entered will be visible from the drop-down window when 

activating the BIM Model tool, available in the Architecture tab, in the BIM Model group. 

This panel will allow filtering by categories and an "analytical" view of the model. 

Elements can be edited from this panel. 

Steps to follow for creating floors slabs: :  

1. Define, if necessary, floor slab types (with the Typology of 

architectural elements tool). 

2. Select an appropriate view, activate the desired layer and view of the 

required reference elements. 

3. Click on the Floor slab tool, which can be found under the Architecture tab 

in the Construction elements group in the Horizontal elements drop down 

menu. When clicking on Horizontal elements, a small floating window will 

appear that can be attached to one of the sides of the graphic window; in 

the toolbar, the Floor slab tool is included, among others. 

4. Once the tool has been activated, a small floating menu will appear, 

allowing the features of the new floor slab being created to be defined; if 

desired, a type can be loaded: 

 Reference. The one proposed by the application can be modified. 

 Level. Reference level for the new element, important for filtering later on. 

 Entry mode. Floor slabs can be entered in two ways: By points and By 

surface area. For the first option, users simply enter a series of points to 

define the reference polygon for creating the floor slab. For the second, 

users must select a sketch element (plane defined by a closed contour). 
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 Type. If types have been previously defined, one of the existing ones can 

be selected from the folder icon; this will cause the defined parameters 

for the type to be filled in automatically and linked to the features defined 

for it. 

 Category. Allows the use or relative position of the element being created 

to be defined.  

 Thickness. 

 Colour. For floor slabs, a different definition is allowed for the Top face, 

Bottom surface, and Front. 

 Adjustment. Defines the direction of the extrusion from the generating 

plane. 

5. Once the properties of the floor slab have been defined, it is time to place 

it in the graphic window. To do this, several issues must be considered: 

 If a By points Entry mode has been chosen, all the considerations 

made for placing columns related to the 3D/2D entry mode and the 

use of references must be considered. For floor slabs, the 

introduction of points, one per vertex, must be completed; right 

clicking the mouse will end the introduction and create the 

construction element. 

 If a By surface area Entry mode has been chosen, users simply have 

to select a plane enclosed by a contour; immediately after, the floor 

slab will be created. In order to have a generating plane, a closed 

outline must be defined with the drawing tools available in the Sketch 

tab. 
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3.9 Vertical elements II: Walls 

The Wall tool allows vertical or inclined surface elements to be created; the tool will allow 

different categories to be distinguished: External façade, Party wall, Internal partition or 

Basement wall. 

 

Steps to follow for creating walls :  

1. Define, if necessary, wall types (with the Typology of 

architectural elements tool). 

2. Select an appropriate view, activate the desired layer and view of the 

required reference elements. 

3. Click on the Wall tool, which can be found under the Architecture tab in 

the Construction elements group in the Vertical elements drop down 

menu.  

4. Once the tool has been activated, a small floating menu will appear, 

allowing the properties of the new wall being created to be defined; if 

desired, a type can be loaded: 

 Reference. The one proposed by the application can be modified. 

 Level. Reference level for the new element, important for filtering 

later on. 

 Entry mode. Walls can be entered in three ways: By polyline, By points 

and By surface area. The first case will be the usual one in BIM 

modelling applications, i.e., guidelines will be drawn to create vertical 

walls with the desired height, thickness, and direction of lateral growth. In 

the second case, a series of points need only be entered to define the 

reference polygon for the creation of the wall (this will allow the creation 

of free-form walls). In the third case, a sketch element (plane defined by a 

closed outline) must be selected.  

 Type. If types have been previously defined, one of the existing ones can 

be selected from the folder icon; this will cause the defined parameters 

for the type to be filled in automatically and linked to the features defined 

for it. 
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It can be deduced from the various wall entry modes that there is a great deal of 

modelling freedom. The By polyline entry mode allows conventional vertical walls to be 

created quickly using a guideline; on the other hand, the By points or By surface area 

entry modes allow walls to be created without geometrical restrictions. 

 Thickness. 

 Colour. For walls, a different definition is allowed for each of the main 

faces. 

 Adjustment. Defines the direction of the extrusion from the 

generating plane.  

5. Once the properties of the wall have been defined, it is time to place it in 

the graphic window. To do this, several issues must be considered: 

 If a By polyline or By points Entry mode has been chosen, all the 

considerations made in previous points related to the 3D/2D entry 

mode and the use of references must be considered. For creating 

walls By polyline, the programme will wait for the points contained in 

a horizontal line to be entered; the first two points will define the first 

span of wall, for each new point, a new span will be added to the 

chain, right clicking the mouse will end the chain of points, keeping 

the wall tool active. For creating walls By points, the introduction of 

points, one per vertex, must be completed; right clicking the mouse 

will end the introduction and create the construction element. 

 If a By surface area Entry mode has been chosen, users simply have 

to select a plane enclosed by an outline; immediately after, the wall 

will be created. In order to have a generating plane, a closed outline 

must be defined with the drawing tools available in the Sketch tab. 
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3.10 Openings: Doors and windows 

In the Architecture tab, next to the drop-down menus for Vertical elements and Horizontal 

elements, is the drop-down menu for Openings. This drop-down menu includes the 

following creation tools: 

 Opening 

 Door 

 Window 

 Skylight 

 Glazed surface 

The Opening tool allows construction elements to be drilled without adding carpentry 

elements; for the rest of tools, creating an opening will be joined by the placement of a 

carpentry element. 

The Glazed surface tool allows a free geometry to be defined on a construction element 

(wall or floor slab); in all other cases, the geometry of the opening will be determined by 

the carpentry element. 

Although independent carpentry elements can be created, a host element (wall, floor slab 

or roof) is normally used.  
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Steps to follow for introducing doors :  

1. Define, if necessary, door types (with the Typology of 

architectural elements tool). 

2. Select an appropriate view, activate the desired layer and view of the 

required reference elements and hosts. 

3. Click on the Door tool. Once the tool has been activated, a small floating 

menu will appear, allowing the properties of the new door being created to 

be defined; the editor includes a graphic window showing the result of the 

configuration: 

 Type. If types have been previously defined, one of the existing ones can 

be selected from the folder icon; this will cause the defined parameters 

for the type to be filled in automatically and linked to the features 

defined for it. 

 Type of opening. This will allow users to choose one of the types 

available: Hinged door, Hinged door, double leaf, Sliding door, Sliding 

door, double leaf. 

 Door dimensions. This section defines the dimensions of the door that, 

in turn, will define the dimensions of the opening to be created in the 

host element.  

 Glazed opening. Activating this parameter will allow a transparent 

element to be inserted in the leaf, the dimensions of which can also be 

defined. 

 Type of handle. Activating this parameter will allow a handle element to 

be inserted, which can be chosen from the types available in the drop-

down menu. 

 Colours. Colours can be assigned to the different sub-components: 

Frame, Door, Handles and Glass. 

4. The previous editing window will give way to a small floating menu with the 

following individual options: 

 Reference. The name proposed by the application can be modified. 

 Level. Reference level for the new element, important for filtering later 

on. 

 Insertion point. Any of the references shown graphically may be 

defined. 

 Adjustment. It will define the direction of creation from the generator 

plane. 
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5. Once the properties of the door have been defined, it will be time to place it in 

the graphic window, normally onto a host element. To do this, users must 

keep in mind all the considerations made in previous points related to the 

3D/2D entry mode and the use of references; placement on a host element 

will require activating Object snap (Nearest, Midpoint, etc.). 

6. Once the insertion point has been selected, a second click will be required to 

define the direction and rotation of the door; a plan symbol will allow the 

position relative to the cursor position to be previewed. 

7. A third point will be required to define the relative position of the door in the 

host element. The application shall allow a choice between the outer plane, 

the inner plane, and the middle plane. 
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Steps to follow for introducing windows :  

1. Define, if necessary, window types (with the Typology of 

architectural elements tool). Select an appropriate view, 

activate the desired layer and view of the required reference 

elements and hosts. 

2. Click on the Window tool. Once the tool has been activated, a small 

floating editor similar to the one for doors will appear: 

 Window shape. A Rectangular Window or a Circular Window can 

be chosen. 

 Type of opening. This will allow users to choose one of the types 

available: Fixed window, Hinged window, Sliding window. 

 Dimensions of the opening. This section defines the dimensions of 

the opening in which the carpentry will be placed.  

 Number of leaves. 

3. The previous editing window will give way to a small floating menu with 

the following individual options shown for windows and also: 

 Height above the ground. Activating this parameter will allow the 

window to be raised a certain distance above the reference plane. 

4. Once the properties of the window have been defined, it is time to place 

it in the graphic window, normally onto a host element. To do this, all 

the considerations made in previous points regarding the 3D/2D entry 

mode, and the use of references must be considered; the placement on 

a host element will require activating Object snap (Nearest, Midpoint, 

etc.) 

5. A third point will be required to define the relative position of the 

window on the host element. The application will allow users to choose 

between the outer plane, the inner plane, and the middle plane. 
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3.11 Editing tools 

The Architecture tab includes a set of general editing tools: 

 Edit 
Allows users to select a model element and edit its parametric 

properties. 

 
Delete Works in the same way as pressing the DELETE key. 

 Move 
Allows multiple elements to be selected (right clicking the mouse 

will end the selection).  

 
Rotate Allows multiple elements to be selected. 

 Copy Works similarly to Move. 

 

Edit 

geometry 

Allows users to edit the vertices of an existing architectural 

element. 

 

Copy 

properties 

Allows the following properties to be transferred between 

elements: Level, Description, Category, Height, Thickness and 

Colour. 

 
Search by 

reference 

As its name implies, it allows users to search for elements by 

reference. 

 

 

Also included are useful tools for intersection solutions between construction elements: 

 

Intersection 

solutions 

This tool will automatically resolve the intersections between the 

construction elements entered (overlaps, extensions, etc.).  

This function can be applied to all the joints present in the model 

or only to those pending solutions. 

 

 

 

When copying or moving objects, entering a start point and an end point will define the 

displacement vector (activating coordinate introduction and/or orthogonal mode will be 

especially useful). 
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The tools described below will allow intersections to be solved in a more manual way. 

 
Subtract 

Allows the intersection between two elements to be removed; the 

intersection will be removed from the first selected element. 

 Extend face 
Allows the face of an object to be selected and stretched to any 

reference plane. 

 

Slice with 

surface 

Allows users to remove the part of an object on one side of the 

plane defined by one of its faces. 

 

Cut by 

plane 

Allows users to remove the part of an object lying on one side of 

the selected plane (unlike the previous one, the cutting plane can 

be defined by faces of other objects). 

 
Regenerate 

Allows users to restore the original geometry of the object (i.e., 

undo all changes made by the other tools in the group). 

 

 

 

3.12 Roofs (sketch modelling) 

The Roofs drop-down menu, included in the Construction elements group (Architecture 

tab) offers three tools: 

 Slope formation. This tool allows a new volumetric element to be created from the 

perimeter, elevation difference and height of the drain. The new element will be 

At this stage, some elements may need to be copied from one level of the model to 

another; this is explained step by step in section 3 of this chapter (Levels). 
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created with a height defined by the Slope parameter and, depending on the geometry 

of the perimeter, it will generate drainage planes towards the point of the drain that 

will be located at a relative height defined by the Height of the drain parameter. 

 Roof tiles. The roof tile tool will create a set of roof tiles modelled on a plane to be 

defined by a free form closed perimeter. Once the perimeter has been defined, the 

definition of a polyline will be required to define the direction of the slope and the 

placement of the tile lines.  

 Special roof element. Allows the detailed modelling of traditional roof tiles by adding 

ridges or ridges defined by polylines. 

 

 

 

 

Alongside the specific tools for creating roof elements, the application allows the modelling 

of sloped slabs that can be used to support the previous elements. The creation of sloped 

slabs does not require any other instructions than those included in the previous section 

(Steps to follow for creating floor slabs); however, it is necessary to have a sloped reference 

for creating the slab, which will require that the user remembers how to use the sketch 

tools. 

An icon is available on the display panel to activate or deactivate the visibility of tiles 

and special roof elements. 
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Steps to follow for creating sloped floor slabs:  

1. Activate the Sketch tab. Activate the visibility of the Sketch elements, if 

necessary. 

2. Click on the Line tool and activate the 3D mode for introducing points. 

3. Introduce two points to define the border that will later limit the floor slab 

at the bottom. Right click to finish the line. 

4. There are many ways of defining the geometry; to do this in a very graphic 

way, we will copy the previous line at a certain distance, keeping the same 

dimension. This line will represent the projection of the upper edge of the 

slab. 

5. Activate Orthogonality (CTRL+O) and move the last line created along the Z 

axis to the desired dimension. 

6. Activate the Line tool again and connect the ends of the two previous lines 

(deactivate Orthogonality to be able to insert inclined lines). 

7. Connecting the previous lines will result in a sloped plane, which will be 

used as a reference for creating the floor slab. 

8. Return to the Architecture tab and follow the steps in the previous section 

(Steps to follow for creating a floor slab) and select the By surface area Entry 

mode. 
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3.13 Connections: stairs 

 

The Construction elements group in the Architecture tab includes a final drop-down menu 

for Connections. This button will open a toolbar that includes the following features: 

 Stair span. This is the basic stair generation tool; it allows to generate stair spans by 

defining Stair width, Number of steps, the Tread and Riser as well as some additional 

features. 

 Stair span defined by three points. Similar to the previous tool, it allows stair spans to 

be generated from the definition of a riser height, width, and a height to be saved (the 

width and height will be entered graphically). 

 Stairwell. Allows a stairwell to be automatically generated from the joint definition of 

spans, landings, and railings. The tool can be used to generate repetitions of 

conventional staircases: straight stairwells and stairwells rotated at 90 and 180º.  

 Ramp span. Similar to Stair span; in this case the ramp width, length and height will be 

defined. 

 Ramp span defined by three points. Similar to Stair span defined by three points, in 

this case users simply have to define the width and height. 

 Ramp core. Similar to Stairwell. The tool can generate repetitions of straight ramps or 

ramps rotated at 90 and 180º.  

 Elevator/Lift. This tool allows the simple modelling of the lift cabin with freely 

definable geometric properties. Once the properties for the lift cabin have been 

defined, the tool allows the different Entrance stops to be defined; this will lead to a 

reserve space being created in the model. Any other adjustments can be made with 

the Edit tool.  

Once the architectural elements have been created, the previously created sketch 

elements can be deleted or hidden. Remember that the editing tools are specific to 

sketch, architectural and furniture elements; to delete sketch elements you must activate 

the tool found in the Sketch tab. 
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 Lift defined by three points. With the same result as the previous tool, it will allow the 

geometry on the graphic window itself to be defined. 

 Landing. Allows users to add landings to the detailed design of staircases; usually they 

will be added to the spans created independently with the Stair span tool; working in 

3D mode is particularly convenient. The configuration of the element parameters and 

its creation mode is completely identical to that of Floor slabs.  

 Railing. Allows railings to be added to the connection elements included in the toolbar. 

Its configuration requires entering data for its height, type of handrail, etc., and the 

graphic definition of its direction on the graphic window. Working in 3D mode is 

particularly convenient. 

 Curved ramp span. Allows a curved ramp span to be created from the geometric data 

of the External radius, Internal radius, Elevation difference of the ramp, Thickness, 

Initial angle, and Final angle. Once the parameters have been defined, users simply 

need to locate its centre. 

 Curved ramp span given the height and width. Similar to the previous tool, it allows 

the thickness and height of the ramp to be defined graphically. 

 Curved ramp span given the centre and two points. Similar to the previous tool, it 

allows the ramp to defined from the starting edge, an insertion point and a final point 

to define the end of the ramp. 

 Extend radius. Allows the radius of an existing ramp to be modified (a floating 

checkbox will show the resulting slope. 

 Move centre. Allows the centre of an existing ramp to be moved.  
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Steps to follow for creating a straight stair span with a landing:  

1. Define, if necessary, types of Stair span and Landings select one of the 

appropriate Views, activate the desired Layer and the View of the necessary 

reference elements. 

2. Click on the Stair span tool. Once the tool has been activated, a small floating 

menu will appear, allowing the properties of the new stair span being created 

to be defined: 

 Reference. As usual, the application will propose a name that can be 

modified as desired. 

 Level. The level associated with the span must be defined. 

 Stair width. Enter the desired width for the span being created. 

 Number of steps. Enter the number of complete steps (Tread + Riser) to be 

created. 

 Enter the desired dimensions for the Tread and Riser. Activate or 

deactivate the With nosing checkbox. 

 Expand the Category group to define other parameters such as the stair 

span type (In-situ, Monolithic stair, Floating and Precast). 

 Depending on the type chosen in the previous step, additional parameters 

will be offered; for example, for the In-situ stair span type, the thicknesses 

of the floor slab in the stair span itself, the floor slab above and the floor 

slab below must be defined. These thicknesses must match the 

thicknesses of the floor slabs or landings with which the current span is 

going to be connected. 

 Define, if desired, the Colours for the different sub-components created. 

3. In the graphic window, the stair span with the properties that have been 

defined will appear, users must simply click on the point of placement; 

working in 3D mode is particularly convenient. A right click will close the 

command. 

4. Click on the Landing tool. Once the tool has been activated, a floating editor 

will appear, allowing users to define the properties of the new stair span 

being created: 
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 Reference. As usual, the application will propose a name that can be 

modified as desired. 

 Level. The level associated with the span must be defined. 

 Entry mode. Choose between the By geometry, By points or By surface 

area entry modes. In the first case, users must simply define the plan 

dimensions (X and Y); for the other two, the same procedure for defining 

floor slabs can be followed (By points or By surface area). 

 Thickness. Define the thickness of the Landing (it must match the 

thickness defined in the parameters for the stair span). 

 Define, if desired, the Colours for the different sub-components created.  

5. On the graphic window, the landing with the properties that have been 

defined will appear, users must simply click the placement point; working in 

3D Mode is particularly convenient. A right click will close the command. 

6. Insert the remaining spans or landings until the desired staircase is 

complete. 
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3.14 Spaces 

Spaces are elements that are used for identifying both interior and exterior volumes in the 

project. 

In any case, it is convenient to define spaces in the model to help in the subsequent 

definition of the analytical model, which will allow users, as its name indicates, to analyse 

the building thermally and acoustically. Defining spaces is important for developing other 

specialties. 

In the Architecture tab, a specific group is dedicated to creating and modifying Spaces. This 

group includes the following tools: 

 Space by polyline. This is the basic tool for generating spaces. Once activated, a 

Reference, Level, Category and Colour can be associated to them (spaces can also be 

associated to predefined types). Furthermore, a Height must be defined for the space 

as well as a Text height for the representation of the reference in the graphic window. 

 Space by wall and floor slab. Similar to the previous tool, it allows spaces with desired 

properties to be generated from a selection of perimeter walls and a base floor slab. 

 Detect spaces on plan. Allows spaces to be created automatically in a plan view. Once 

the properties have been defined, users can simply place the cursor in a space 

delimited by walls (for the tool to work correctly, the guidelines that generate the walls 

must effectively close an interior space). 

 Adjust space. The spaces, by default, will be generated in the shape of a straight prism; 

if this geometry must be adjusted due to the presence of walls or inclined floor slabs, 

this tool can be used to make this adjustment automatically. 
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3.15 Detailed modelling 

In the previous points all the main modelling tools have been shown. In the application, 

however, other minor tools are included that allow detailed modelling. These tools are 

briefly presented in the following list: 

Vertical elements 

 Railings. As well as the option included in the Connections group, the Vertical 

elements toolbar includes this tool. The tool (as opposed to the one integrated in the 

Connections group) is intended for placing protective elements on horizontal elements. 

It allows the geometry and colour of the various sub-components: Posts, Handrails, 

Balusters and Panel to be defined. 

 Louvres. Allows louvres with horizontal or vertical slats to be created. The tool allows 

users to control the geometry and colour of the different subcomponents: Mullion and 

Slats. 

 

 Curtain wall. Similar to the previous tools, it allows users to create curtain walls and to 

define their geometry, separation, and colour of their different subcomponents: 

Transom and Mullion. 

It is especially convenient to place the spaces in a specific layer to control their 

visualisation during the modelling process. 
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Horizontal elements 

 Suspended ceiling. With the same entry modes used for Floor slab, the tool allows a 

Continuous suspended ceiling or Removable suspended ceiling to be modelled. When 

working on a plan view, it is possible to enter elements by means of outline detection 

(in a similar way to the one mentioned for Spaces). 

 Beam. Allows directrix and rectangular section elements to be generated.  

 

 

3.16 Furniture 

 The Furniture tab includes, in addition to a group of Edit tools (Edit, Copy, Delete, Move 

element group, Rotate a group of elements and Measure lengths), specific groups for 

Furniture, Home appliances, Sanitary appliances and Garden. 
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Placing these elements will help to understand the model and provide possible uses for the 

spaces. Furthermore, the Sanitary appliances can be imported from other applications for 

analysing and designing installations; in this case, they will be converted into consumption 

and possible connections to the different supply and/or sanitation networks; for example, 

home appliances can be imported from Open BIM Electrical Mechanism. 

Moreover, placing them on the model will be instantaneous, users simply have to click on 

the required element, define its Reference, Level, Properties (model and/or type, if 

applicable), Colours and then position it in the desired location. 

 

 

Steps to follow for placing a toilet 50cm to the right of a partition wall:  

1. Although it is not necessary, creating a sketch element will help visualise the 

references. Draw a line (CTRL+L) from any point on the partition wall to the 

end which will be used as a reference. 

2. Activate Coordinate introduction in the top toolbar. 

3. Click on the Toilet tool; enter the required Reference, Level and Type data. 

Click Accept; do not enter any point on the model yet. 

4. In the Coordinate introduction window, click on the button located on the 

right (Last point) this will display the last point entered (the end point of the 

line) on the model; it will appear as a small yellow cross. 

5. Click on the Relative coordinates option (dxy) and enter the relative 

coordinates for X:0.5m, Y:0.0m, Z:0.0m which will be measured from the 

point indicated in the previous step. Press ENTER when all three fields have 

been completed. 

6. The toilet placement point (which will coincide with the point indicated in 

the previous step) must now be entered, so enter the value zero in the 

X:0.0m, Y:0.0m, Z:0.0m, Z:0.0m fields and press ENTER. 

7. Right click to close the tool. 

 

For placing Furniture elements, the use of relative coordinates is particularly convenient; 

this way, it is possible to control the exact position of these elements compared to other 

architectural elements. 
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3.17 Sharing the project 

3.17.1 Exporting to BIMserver.center 

Once the model is finished, simply click on the Share tool to upload a copy of the model to 

BIMserver.center and make it available to project collaborators.  

The BIMserver.center platform is a software repository for projects where users can share 

and access them from any device at any time.  

In a transparent process for the user, the application will create a copy of the model in IFC 

format, save it in the work team’s local path and, using the synchroniser, upload the model 

to the BIMserver.center cloud. 

The application will be able to generate other visualisation and information exchange files 

such as glTF files, a file format for scenes and 3D models based on the JSON standard. 

Should the model include, in addition to Construction elements, Spaces or Furniture or 

Sanitary Appliances, separate models will be generated, allowing users to activate or 

deactivate the visibility of each of them independently, on the viewer incorporated in 

BIMserver.center. 
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3.17.2 Updating BIMserver.center files 

 Once other files are added to the BIMserver.center project, if, while working, any of the 

collaborators modify their part or include a new part in the project, the Update button in 

the BIMserver.center section will blink indicating that there are new files or changes. 

New files can be loaded by clicking the Update button and choosing the files to be 

uploaded. In the Changes column, users can see which files are in use, if any changes have 

been made or if there are any new files. 

 

 

3.17.3  Viewing results on BIMserver.center 

BIMserver.center allows the models to be viewed from any mobile device, tablet or 

computer. This way they can be easily accessed at any time.  

From BIMserver.center you will be able to access all the information generated by the 

different tools in the Open BIM workflow. 
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